
They came, they saw, they went – even having the now obligatory mic-
drop (pictured).  From left to right, MVPs Gašper Kamenšek, Ken Puls, 
Liam Bastick, Jon Peltier, Mynda Treacy and Microsoft’s Annie Colonna 
(together with SumProduct’s own other MVP Tim Heng in Sydney), 
the gang provided sessions on charts, dashboards, the new data types  
(see below), financial modelling, Power Everything and VBA.  

The biggest success story of the entire event was in Brisbane where one 
attendee has seen a regular five-and-a-half-hour task become a less than 
30-second event.  And they say the event doesn’t pay for itself!

If you were there, we hoped you enjoyed it.  If you weren’t, make sure 
you bookmark next year’s sessions.  The event will be back again in 2019.  
Watch this space for news on this – and other events – later in the year.  

NEWSLETTER #66 - May 2018

Excel takes centre stage this month ... There’s certainly new 
things to mention: two new data types, a new function, a new error message, enhancements for Mac Excel and two translators.

But that’s not all.  We wrap up the recent Unlock Excel event, highlight the forthcoming Amsterdam Excel Summit and discuss the 
latest updates for Power BI Desktop, Service and Mobile.

With the usual regular features such as Power Query Pointers focusing on essential calendar tables, the A to Z of Excel 
Functions (this month, we review CONFIDENCE to a T!) and more Keyboard Shortcuts, there’s plenty to read.
Until next month.

Unlock Excel Summit – Wrap Up
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Liam Bastick, Managing Director, SumProduct

From all of us at SumProduct, we were a little overwhelmed by the response to last month’s 
announcement that our book, Introduction to Financial Modelling, is soon to come out.  Thank 
you to everyone who has signed up for a copy.

In fact, due to a printing delay, the book is taking slightly longer to be released than we expected 
last month.  Nonetheless, the book will be released shortly and we hope to start shipping the 
books before the end of this month (May).

If you haven’t yet signed up for a copy and would like one (or 50), or would like to find out 
more, simply drop us a line at contact@sumproduct.com.

Book Update
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After all of the endless updates for Power BI and Power Query, there’s 
finally some exciting news for those using Excel 2016 on an Office 365 
basis (i.e. not the “perpetual licence”).  You might not have this initially, 
but don’t fret.  According to Microsoft, this feature is being made 
available to users on a “gradual basis” over several days or weeks. It will 
first be available to Office Insider participants and later to Office 365 
subscribers.  If you are an Office 365 subscriber and you want it is as soon 
as it becomes available, do ensure you have the latest version of Office at 
all times (keep those updates updated!).

So what’s the big deal?

For a start, you can now get stock and geographic data in Excel.  All you 
have to do is type text into a cell and convert it into the ‘Stocks’ data 
type or the ‘Geography’ data type.  These two data types are new, and 
they are considered linked data types because they have a connection 
to an online data source.  That connection allows you to bring back rich 
information that you can work with and refresh.  You know – the things 
you have wanted to do for years!

Here’s a peek at the two new data types:

In this graphic, the cells with company names in column A contain the ‘Stocks’ data type.  You may tell this because they have this icon .  The 
‘Stocks’ data type is connected to an online source that contains more information.  Columns B and C are extracting that information.  Specifically, 
the values for price and change in price are getting extracted from the ‘Stocks’ data type in column A.

In this example, column A contains cells that have the ‘Geography’ data type.  This time, the  icon indicates this.  This data type is connected to 
an online source that contains more information.  Columns B and C are again extracting that information.  Specifically, the values for population and 
gasoline price are getting extracted from the ‘Geography’ data type in column A.

We are sure you can see how these data types might be useful.  So how do you set it up?  Assuming you have had your version of Excel 2016 updated, 
it’s as easy as, er, 1, 2, 3, 4, 5, 6…

That’s right: just type some text in cells.  In this example, we wanted data based on geography, so we typed country names.  However, you could also 
have typed province names, territories, states, cities, etc.  If you want stock information, similarly type company names, fund names, ticker symbols, 
and so on.

New Data Types and FIELDVALUE Function

Data Type 1: Stocks

Data Type 2: Geography

Step 1: Type Some Text

mailto:contact@sumproduct.com
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Although it's not required, it is recommended you create an Excel Table.  This is so ranges may be extended readily and easily later, should you wish.  
Select any cell in your data and go to Insert > Table or use the keyboard shortcut CTRL + T.  This will make extracting online information easier later on.

Step 2: Create a Table

Next, select the cells that you want to convert to a data type.

On the ‘Data’ tab, click either ‘Stocks’ or ‘Geography’.

If Excel finds a match between the text in the cells and the online sources, it will convert your text to either the ‘Stocks’ data type or ‘Geography’ data 
type.  You will know immediately if they have been converted since they will have the  icon for stocks and the  icon for geography.

Step 3: Select Some Cells

Step 4: Pick a Data Type

Step 5: Icons Appear

mailto:contact@sumproduct.com
http://www.sumproduct.com


In this example, cell B2 contains the formula =A2.Price and cell C2 contains the formula =A2.Change.  When the records are in a Table, you can 
use the column names in the formula instead.  In this case, cell B2 would contain the formula =[@Company].Price and cell C2 would contain  
=[@Company].Change.  The additional benefit is that these formulae would automatically copy down too.

Some tips for when you start playing with these two new data types: 

	 •	 as soon as you type the dot operator (.) after a cell or column reference, Excel will present you with a formula AutoComplete list of fields that 	
		  you can reference for that data type.  Select the field you want from the list or type it if you know it
 

	 •	 data type field references are not case sensitive, so you can enter =A2.Price, or =A2.price
	 •	 if you select a field that has spaces in the name, Excel will automatically add brackets ([ ]) around the field name, e.g. =A2.[52 Week High]
	 •	 the FIELDVALUE function can also be used, but it is recommended only for creating conditional calculations based on linked data types.

This last point is a nice lead into the other new item…
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Click the ‘Add Column’ button , and then click a field name to extract more information, such as ‘Population’.

If you see the  symbol instead of an icon, then Excel is having difficulty matching your text with data in Microsoft’s online sources.  Go back and 
review your data.  Correct any spelling mistakes and when you press ENTER, Excel will do its best to find matching information.  If this does not work, 
click  and a ‘Selector’ pane will appear.  Search for data using a keyword or two, choose the data you want and then click ‘Select’.  That’s it!

Step 6: Add a Column

How to Write Formulae that Reference Data Types

You can use formulae that reference linked data types.  This allows you to retrieve and expose more information about a specific linked data type.  
For example, consider the linked data type, Stocks, used in cells A2:A11 below.  In columns B and C, there are formulae that extract more information 
from the ‘Stocks’ data type in column A, viz.
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The FIELDVALUE Function

You can use the FIELDVALUE function to retrieve field data from linked 
data types like the ‘Stocks’ or ‘Geography’ data types.  There are easier 
methods for writing formulae that reference data types (see above), so 
the FIELDVALUE function should be used mainly for creating conditional 
calculations based on linked data types.

 
Similar to the new data types, this brand-new function is being made 
available to customers on a gradual basis over several days or weeks.  It 
will first be available to Office Insider participants and later to Office 365 
subscribers.  If you are an Office 365 subscriber, make sure you have the 
latest version of Office or you may not get the update when it’s your turn.

Technical details

Syntax 

=FIELDVALUE(value, field_name) 

The FIELDVALUE function syntax has the following arguments:

•	 value: this is the cell address, table column or named range that contains a linked data type
•	 field_name: this is the name or names of the fields you would like to extract from the linked data type.

Description 

The FIELDVALUE function returns all matching fields(s) from the linked data type specified in the value argument.  This function belongs to the 
Lookup & Reference family of functions.

Examples 

In the following basic example, the formula, =FIELDVALUE(A2,"Price") extracts the Price field from the ‘Stock’ data type for the “internationally-
renowned” JM Smucker Co.

Word to the Wise

If you try to retrieve data from a non-existent data type field, the FIELDVALUE function will return the new #FIELD! error.  For instance, you might 
have entered "Prices", when the actual data type field is named "Price".  Double-check your formula to make sure you've used a valid field name.  If 
you want to display a list of field names for a record, select the cell for the record and press CTRL + SHIFT + F2.

Happy playing with your new toys!

FIELDVALUE will be detailed in our blog series A to Z of Excel Functions in due course.  You can find out about other functions in our current list here.

The next example is a more typical example for the FIELDVALUE function.  Here, we’ve used the IFERROR function to check for errors.  If there isn't 
a company name in cell A2, the FIELDVALUE formula returns an error, and in that case, displays nothing ("").  However, if there is a company name, 
then we want the formula to retrieve the Price from the data type in A2 with =IFERROR(FIELDVALUE($A2,B$1),"").

Note that the FIELDVALUE function allows you to reference worksheet cells for the field_name argument, so the above formula references cell B1 
for Price instead of manually entering "Price" in the formula. 

https://www.sumproduct.com/thought/a-to-z-of-excel-functions
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Bonjour!  FIELDVALUE et al is not all that’s happened.  There’s more.  And it’s not just for Microsoft Excel, this latest update to the Office 365 
"mainstream" collection also works in Word and PowerPoint (there's even an add-in for Outlook too).  Located on the 'Review' tab of the Ribbon in 
the 'Language' grouping (of just one item presently!), 'Translate' allows you to, er, translate from one language to another.

Not to be confused with the Translator (above), the Excel Functions Translator is a new add-in that assists users utilise a localised version of Excel by 
helping translate from the US Excel function names or research how to create a solution on the web with predominately English content.

This tool allows non-English Excel users to locate the equivalent localised functions and formulae in any of the (so far) supported 15 languages:

	 •	 Chinese Traditional
	 •	 Chinese Complex Script
	 •	Danish
	 •	Dutch
	 •	 French
	 •	German
	 •	 Italian
	 •	 Japanese

Ironically, one of the primary developers is Ukrainian and this language is not yet on the above list!

Presently, the Functions Translator will automatically configure the language settings to English-US and the localised version.  If this is not what you 
require, it is possible to provide feedback to Microsoft on the translation of functions if it is not what they expected. 

The solution supports Excel Online, Excel 2013 and Excel 2016 for Desktop, and the latest version of Excel for Mac and iPad.

All you have to do is highlight the cell or text you want to translate and then click on the button.  In Word or PowerPoint, you will then have to select 
'Insert', but in Excel you simply copy the data into the 'Translator' pane.

Se trè fasil pou sèvi ak tradiktè a!

Microsoft Translator for Excel

Excel Functions Translator

•	 Korean
•	 Portuguese Brazilian
•	 Russian
•	 Spanish
•	 Swedish
•	 Turkish
•	 US English (!).
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Microsoft’s “Garage Team”, responsible for this add-in, make it clear that this is a Work In Progress.  The aim of this tool is to eventually accomplish 
the following goals:

	 •	 enable users who know the English-US functions to become productive in localised versions of Excel
	 •	 enable users to easily translate full formulae they find on the web into their native language
	 •	 support all localised languages and functions of Excel (80 languages and according to Microsoft, 800 functions although we haven’t found that 	
		  many!)
	 •	 provide an efficient way to search for any part of a functions name, in both languages selected
	 •	 show a scrollable and categorised list of English-US functions and the corresponding localised functions
	 •	 enable the users to give feedback to Microsoft on the quality of the translations of the functions, both good and bad
	 •	 enable Microsoft to support users that are struggling with finding the wanted function in a localised language
	 •	 support Excel 2013 and 2016 for Desktop, Excel Online, and the latest version of Excel for Mac and iPad.

It’s not all there yet, but you can see this road is definitely paved with good intentions.  It’s taken the team 20 months to get where they are now.  
Part of this delay is apparently attributable to overcoming Microsoft’s own terms and conditions pertaining to security, privacy and accessibility!

If you want the add-in, it’s available at the online store now – simply click here for your copy.  

Excel for Mac 2016 version 16.9.0 has been live since the turn of the 
year, with several since.  The version 16 release is powered by the Office 
Code convergence, i.e. the move towards one Excel for all.  It’s built from 
the same codebase as Excel for Windows, while also being integrated 
with macOS and tailored to Mac UI and capabilities like TouchBar.  

Excel for Mac has a very large and engaged customer base (that we often 
annoy!), so it is important for Microsoft to keep powering through the 

improvements and convergence.  Indeed, Microsoft has kept an eye 
on Excel’s UserVoice site, where more than 50% of the Mac features 
requested (by number of votes) have been implemented.  It is important 
to note that those some of these updates or new features are included 
only for Office 365 subscribers as the push towards this program 
continues unabated.   Here’s a summary of the key features: 

New Features, Functions and Performance in Excel for Mac Version 16

Collaborative Editing and AutoSave

Ah yes, we start with one of our favourites.  Not.  This feature 
allows Mac users to work with others at the same time in your 
workbook (that’s fine).  The thumbnails in the upper-right 
corner of the window show who else is viewing or editing the 
file with you.  

However, Excel is now equipped with AutoSave for files 
stored on OneDrive or SharePoint Online.  If you work in 
modelling, you are going to keep your files away from the 
Cloud then since AutoSave is exactly what it sounds like: your 
file is automatically saved every few seconds.  We accept that 
if other people are working in the same file, they can see your 
changes almost instantaneously.  But you don’t always want 
everything saved, although we do accept that if you need to 
roll back, you can check your file’s version history for a list of 
changes and access earlier copies – but that is a hassle that 
can be avoided.  The thing to remember is we led the crusade 
to ensure AutoSave may now be switched on and off using a 
dedicated toggle button in the Ribbon!

https://appsource.microsoft.com/en-us/product/office/WA104381504
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More Charts

You can now use the “new” charts (they have been around about three years…), such as funnel, sunburst and histogram, to transform your data into 
professional visualizations, or use the new Map chart type to transform geographic data into a map to tell a story.

More Functions

There’s a couple of new logical functions, IFS and SWITCH.  Both of these functions have just celebrated their second birthdays in the PC world!  
Here’s a reminder of what they do.

IFS

As model developers and reviewers, we must confess we are not convinced about this one.  If you have ever used a formula with nested IF statements, e.g.

=IF(IF(IF…

then maybe this function is for you – however, if you have ever written Excel formulae like this, then maybe Excel isn’t for you!  There are usually 
better ways of writing the formula using CHOOSE or INDEX(MATCH) (see www.sumproduct.com/thought/index-match.html for more) for example.  

The syntax is as follows:

IFS(logical_test1, value_if_true1, [logical_test2, value_if_true2], [logical_test3, value_if_true3],…)

where:

	 •	 logical_test1 is a logical condition that evaluates to TRUE or FALSE;
	 •	 value_if_true1 is the result to be returned if logical_test1 evaluates to TRUE.  This may be empty
	 •	 logical_test2 (and onwards) are further conditions that evaluate to TRUE or FALSE also
	 •	 value_if_true2 (and onwards) are the respective results to be returned if the corresponding logical_test evaluates to TRUE.  
		  Any or all may be empty.

Since functions are limited to 254 arguments (sometimes known as parameters), the new IFS function can contain 127 pairs of conditions and results.

One thing to note is that IFS is not quite the same as IF.  With the IF statement, the third argument corresponds to what do if the logical_test is not 
TRUE (i.e. it is an ELSE condition).  IFS does not have an inherent ELSE condition, but it can be easily generated.  All you have to do is make the final 
logical_test equal to a condition which is always trues such as TRUE or 1=1 (say).  

Other issues to consider:

	 •	Whilst the value_if_true may be empty, it must not be omitted.  Having an odd number of arguments in an IFS statement would give rise to 	
		  the “You’ve entered too few arguments for this function” error message.
	 •	 If a logical_test is not actually a logical test (e.g. it evaluates to something other than TRUE or FALSE, the function returns an #VALUE! error.  	
		  Numbers still appear to work though: any number than zero evaluates as TRUE and zero is considered to be FALSE.
	 •	 If no TRUE conditions are found, this function returns the #N/A! error.

To show how it works, consider the following example.  

http://www.sumproduct.com/thought/index-match.html
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Here, would-be gurus are graded based on evaluation criteria in the table, applied in a particular order:

=IFS(H13="Yes",I13,H14="Yes",I14,H15="Yes",I15,H16="Yes",I16,TRUE,"Not a Guru")

I think it’s safe that although it is reasonably straightforward to follow, it is entirely reasonable to say it’s not the prettiest, most elegant formula ever 
put to Excel paper.  In particular, do pay heed to the final logical_test: TRUE.  This ensures we have an ELSE condition as discussed above.

To be fair, one similar solution using legacy Excel functions isn’t any better:

=IF(H13="Yes",I13,IF(H14="Yes",I14,IF(H15="Yes",I15,IF(H16="Yes",I16,"Not a Guru"))))

Lovely.

SWITCH

SWITCH is already available in many alternative programming languages and can simplify potentially horrible formulae.  This function evaluates an 
expression against a list of values and returns the result corresponding to the first matching value.  If there is no match, an optional default value 
may be returned.  The syntax is as follows:

SWITCH(expression, value1, result1, [default or value2, result2],…[default or valueN, resultN])

where:

	 •	expression is the value that will be compared against the values (value1 to valueN) cited
	 •	value1 to valueN are the values that will be compared against the expression
	 •	 result1 to result are the values, references or formulae results to be returned when the corresponding valueN argument matches the 	
		  expression.  The result must be supplied for each corresponding valueN argument
	 •	default is an optional value to return in case no matches are found in the valueN expressions.  The default argument is identified by having 	
		  no corresponding result expression, i.e. it must be the final argument in the function where the function contains an odd, rather than an 	
		  even, number of arguments.  If no default argument is supplied and no match is found this function returns the #N/A! error.

To illustrate, consider the following painful formula:

=SWITCH(MID($G13,SEARCH("-",$G13)+1,SEARCH("-",$G13,(SEARCH("-",$G13)+1))-SEARCH("-",$G13)-1),"XS","Extra Small","S","Small","M","M
edium","L","Large","XL","Extra Large","Not Specified")

The expression here is 

MID($G13,SEARCH("-",$G13)+1,SEARCH("-",$G13,(SEARCH("-",$G13)+1))-SEARCH("-",$G13)-1)

which is determining what is contained between the two hyphens (for more on text string functions, please see www.sumproduct.com/thought/
text-messages.html).  It is horrible, and that’s the point.  The formula then considers what the values may be (“XL”,”M”) and what value should be 
returned as a consequence (“Extra Large”, “Medium”).

http://www.sumproduct.com/thought/text-messages.html
http://www.sumproduct.com/thought/text-messages.html
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The corresponding Excel formula before SWITCH would have been a nightmare:

=IF(MID($G13,SEARCH("-",$G13)+1,SEARCH("-",$G13,(SEARCH("-",$G13)+1))-SEARCH("-",$G13)-1)="XS","Extra Small",
IF(MID($G13,SEARCH("-",$G13)+1,SEARCH("-",$G13,(SEARCH("-",$G13)+1))-SEARCH("-",$G13)-1)="S","Small",
IF(MID($G13,SEARCH("-",$G13)+1,SEARCH("-",$G13,(SEARCH("-",$G13)+1))-SEARCH("-",$G13)-1)="M","Medium",
IF(MID($G13,SEARCH("-",$G13)+1,SEARCH("-",$G13,(SEARCH("-",$G13)+1))-SEARCH("-",$G13)-1)="L","Large",
IF(MID($G13,SEARCH("-",$G13)+1,SEARCH("-",$G13,(SEARCH("-",$G13)+1))-SEARCH("-",$G13)-1)="XL","Extra Large","Not Specified")))))

Better Support for PivotTable Charts

Users are now able to change their fields and filters in a PivotTable, and the chart created will automatically adjust to show the changes.
 

Slice and Dice Table Data

Sometimes we forget just what you haven’t been able to do on a Mac.  At long last, you can now use Slicers for Tables to filter your data and see 
what filters have been applied.
 

Improved Visual Basic Editor (Shipped in Oct 2017 Update)

Actually, this was shipped back in the October 2017 update (and described in our newsletter back then), but as a reminder, Mac users may now 
create and edit macros in the Visual Basic Editor using IntelliSense, VBA menus / toolbars, debug tools, an object browser and more.
 

Faster Calculation Speeds

By taking advantage of multiple processing threads, Excel recalculates formulae much faster now when values are changed.  This particular feature 
request on UserVoice (“Will Excel for Mac 2016 utilize multiple cores on Mac?”) was one of the top requests with over 1,730 votes and c.700 
comments.  

Microsoft believes that with 64-bit version of Mac Office (released in September 2016) and with the multithreaded processing enabled, Excel for 
Mac 2016 version 16 is the fastest ever.  
 

Selection Precision

Just as you can on the latest PC updates, you can now deselect extraneous cells without having to start over.

Overall, with the shared cross-platform code, Microsoft is now able to develop and roll out new Office features more quickly and closer to 
simultaneously across various platforms.  The precision selecting is one such feature which shipped in Windows and Mac version simultaneously.  

Hopefully, soon all we will be detailing is new Excel functions and features – without having to discuss which platform they pertain to!

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Excel 2016) from www.sumproduct.com/
blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  Previously, we have talked about the importance 
of creating a Calendar Table.  This month, we show you how to build one using M and a little bit of initiative.

Building a calendar using Power Query is a collaboration between Excel and Power Query.  In my example, I will implement four steps:

	 1.	 Create a table called Parameters in an Excel Worksheet to hold the calendar boundaries 
	 2.	 Create a function fnGetParameter which uses the calendar boundaries as its parameters (we take no credit for this – it is the creation of Ken 	
		  Puls, author of ‘M is for (DATA) Monkey’)
	 3.	 Build the basic dynamic calendar framework
	 4.	 Add any required calendar columns.

Let’s go through the steps.

Power Query Pointers

http://www.sumproduct.com/blog
http://www.sumproduct.com/blog
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1. Creating Parameters

In a new blank Excel Worksheet, let’s create a new table with some specific properties.  Our table is to be called Parameters and has two columns, 
Parameter and Value.

To begin, open a new blank Excel worksheet – in the ‘Insert’ Section, there is an option to ‘Insert Table’ which brings up a ‘Create Table’ dialogue 
box. We’ll choose an area that covers two columns and three rows (for our example, we’ve used A7:B9).  Then, check the box ‘My Table has Headers’ 
and click ‘OK’.

Just as an aside, normally here at SumProduct, we will advocate always starting Tables in cell A1 and calling the worksheet the same name as the 
Table.  We are not going to do that here to show it is not necessary, but there is merit in doing this if data is exported to other programs too.  It’s best 
to give data exporting a “helping hand” on occasion.

Returning to our example, the ‘Table Name’ can be changed in the top left of the screen and must be set to Parameters.  Clicking on the column 
names allows you to set them to Parameter and Value as shown below.

The parameters the function will be using are Start Date and End Date, and these are the entries in my first column.  In the second column, enter the 
date you wish my calendar to begin at, and a formula that will show the last day of the current month. 

	 Parameter	 Value
	 Start Date	 1/1/2016
	 End Date 	 =EOMONTH(TODAY(),0)

This may look like a long number to begin with – the data format on the column needs to be set to Short Date as shown below:
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The Parameter table is now ready for the fnGetParameter function:

2. Create the fnGetParameter function 

In the Power Query menus, create a new blank query by going to the ‘From Other Sources’ section and choosing ‘Blank Query’ from the dropdown:
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In the ‘Query Editor’ screen, choose the ‘Advanced Editor’ from the ‘Home’ tab and enter the following M code:

	 	 	 	 (ParameterName as text) =>
 	 	 	 	 let
	 	 	 	 	 ParamSource = Excel.CurrentWorkbook(){[Name="Parameters"]}[Content],
	 	 	 	 	 ParamRow = Table.SelectRows(ParamSource, each ([Parameter]=ParameterName)),
     		 	 	 	 Value=
	 	 	 	 	 if Table.IsEmpty(ParamRow)=true
	 	 	 	 	 	 then null
	 	 	 	 	 	 else Record.Field(ParamRow{0},"Value")
	 	 	 	 in
    	 	 	 	 	 Value

Then rename the query fnGetParameter.

When you choose to ‘Close and Load’ from the ‘Home’ tab, the new query automatically saves as ‘connection only’ in the workbook pane:

Now we have our parameters and a function which will read them.  Next, we need to create a calendar framework and add columns to create a 
useful calendar. 

3. Build Calendar Framework

In the worksheet used previously, let’s start by creating another blank query, following the same procedure as before, and this time we will call it 
Calendar:  The aim is to generate a calendar framework to build a list of dates between the two parameters that I have specified. 

I begin by entering a simple list in the formula bar:

	 	 	 	 = {1..10}
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As shown above, this gives a column of 10 numbers, which I can prepare for calendar format by transforming.  Notice that Power Query automatically 
presents me with options for transforming a list, which is what this is.

In the ‘Convert’ section I choose to convert my list ‘to Table’, and take the default options:

In the resulting table I right click my column and ‘Change Type’ to ‘Date’, and then rename my column Date.

They may not be current, but they are dates!  Now I need my parameters. 
Note that Day 1 is 31 December 1899, not 1 January 1900 as it is in Excel.  
This is because Power Query disregards 29 February 1900 (unlike Excel) 
as, believe it or not, 1900 was not a leap year.  This “phantom date” was 
created in Excel to be consistent with Lotus 1-2-3 “back in the day”.  By 
changing the start date, all dates after this “phantom date” will coincide 
as the same serial numbers in both Excel and Power Query.

Anyway, returning to the task in hand…

Choose the ‘Advanced Editor’ from the ‘Home’ section.  The editor 
shows the lines already created as a result of the transforming I have 
done.  The ‘Source’ step currently shows my original list of 10 numbers: I 
need to change the source to look at my parameters instead of 1 and 10.  
Therefore, after ‘let’ and before the ‘Source’ line, we need to add our 
parameters, which we will call startdate and enddate thus:

	 	 	 startdate = fnGetParameter(“Start Date”), 
	 	 	 enddate = fnGetParameter(“End Date”), 
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This is because we started with a list of numbers and then tried to use dates instead.  We need to express the dates as numbers, so we need to use 
the Number.From function, viz.

	 	 	 	 startdate = Number.From(fnGetParameter(“Start Date”)), 
	 	 	 	 enddate = Number.From(fnGetParameter(“End Date”)),

When we use these definitions instead, our query returns a column of dates:

In this example, we’ve chosen to add the ‘Year’, ‘Month’, ‘Day’ and ‘Quarter (of Year)’ options.

However, if you try this you will get the following error:

4. Adding More Date Columns
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On the ‘Home’ tab, then choose to ‘Close and Load’ to see that all the Calendar entries have been created as expected.  The entries automatically 
appear in a separate sheet to our Parameters table:

The calendar is ready for use.  More next month!

It seems to come around so quickly, doesn’t it?  Microsoft has just released its latest Power BI Desktop updates into the wild.  This time out, on top 
of the usual visual and data connector improvements, there’s key features allowing users to interact with reports in new ways.  The Q&A Explorer 
enables report consumers to ask their own questions about the data, and buttons let you add interactive elements on your reports.

The full list for April is as follows: 

Reporting

	 •	Q&A Explorer (Preview)
	 •	Buttons to trigger actions
	 •	Combo chart line styles
	 •	 Improved default sort for visuals
	 •	Numeric Slicer now Generally Available

Analytics

	 •	Update your linguistic schema
	 •	New DAX function: COMBINEVALUES()

April Updates for Power BI Desktop
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Custom visuals

	 •	Organisational visuals now Generally Available
	 •	Overview by CloudScope
	 •	 Icon Map by Altius
	 •	Hexbin Scatterplot

Data connectivity

	 •	Adobe Analytics connector now Generally Available
	 •	 SAP HANA connector improvement: port selection
	 •	Dynamics 365 Business Central connector.

Let’s take a look at each of these in turn.

Q&A Explorer (Preview)

This update provides a way to integrate a Q&A experience into your report for your users.  If you want to let them ask questions about the data in 
your report, you may set up an image, shape or button (see next feature) to launch the new Q&A Explorer, now in Preview mode.

You can assign this dialog to an image, shape or button by picking ‘Q&A’ in the ‘Type’ dropdown of the ‘Action’ card (formerly the ‘Link’ card), which 
is where you also can also assign bookmarks or the ‘Back’ action too.

Once the Q&A action is set, while in edit mode, you can CTRL + CLICK the button to launch the dialog and try out the experience.

While you are in edit mode, you may also add suggested questions.  Any suggested questions you add will be available in the dialog for consumers 
to view.  To add suggested questions, just type in the question you have and click the ‘add’ button.  This will add the question to the left suggested 
questions pane.  If you decide later you want to remove a question, just click the “X” next to the question you want to remove.
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Once done, select ‘Save and close’ to save all the suggested questions you added.  These questions are saved to that specific button, so you can add 
multiple Q&A Explorer experiences throughout your report with different suggested questions.

Now, whenever someone is viewing your report, they can click on the button to view the suggested questions you saved and ask any ad hoc questions 
they have as well.

This Q&A Explorer can also return whole report pages back 
as answers.  To do this, you will need to turn Q&A on for 
the page and give it some synonyms.

Now, when someone search for 
those phrases in the Q&A Explorer, 
the page will be shown.
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Optionally, if your report has page level filters, you may want to set ‘Require single selection’.

If you do this, you can use that filter in Q&A to filter the page.  Since drillthrough filters automatically require single selection, they are automatically 
parameters for Q&A pages.  When you create filter parameters like this, you will have to supply a value for the filter for the page to appear in Q&A.

The Q&A Explorer will also carry filters from the source page through into the dialog.  When this happens, you will see a notification at the bottom 
of the dialog.  For example, in the below image we’ve cross-highlighted by Computers right before opening the dialog, so that Category=Computer 
filter is being applied to the answer we’re getting back from Q&A.

This is a Preview feature, so if you assign the Q&A action to a button without turning on the Q’&A Preview feature’ under the ‘Options’ dialog, the 
Q&A Explorer will not open in Power BI Desktop.

The Q&A Explorer does not appear for Publish to Web reports or in Mobile reports (for the time being at least).  However, it will work in Power BI 
Embedded reports.



contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Buttons to trigger actions

Now that there are several different actions that can be triggered by just a click on a shape or image, Microsoft has decided it’s time to add a button 
control to Power BI as well.  These new buttons are geared towards letting you create an app-like experience with interactive elements in your report.

Combo chart line styles

Back in August, line styles and legend options were added for line charts, but at the time you could not use these new styles for combo charts.  This 
update closes that gap and you may now change your combo chart lines to different styles and have that optionally reflected in your legend.

As with images and shapes, you can pick the action that will be performed on click through the ‘Action’ card.  Currently these actions include ‘Back’, 
a specific bookmark, and ‘Q&A’.  For certain icon types, Microsoft will have a default action assigned.  For example, if you select the ‘Q&A’ button, 
the ‘Action’ card will default to ‘Q&A’:

A button can be inserted from the Ribbon, by picking on of several icons 
or selecting a blank button.  Once on your page, you can choose to add 
text, change the icon, add a fill color or give your button an outline.  You 
have lots of control around the look of the icon and text including size, 

colour and alignment.  Once you pick your default look for your button, 
you can then use the dropdown to change how it looks on hover or when 
it is being clicked on.
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Improved default sort for visuals

One of the goals with this update was to make it fast and easy for users to create well-formatted reports.  Last month, improvements were added to 
the default visual placement and this update sees another improvement geared towards ease of use.  Microsoft has improved the default visual sort, 
so you won’t need to change it nearly as frequently.

The new logic for sorting visuals is as follows:

		  1.	If your visual uses a column that has an associated order-by column, it will be sorted by that by default  
			   (you may set this up using the ‘Sort by column’ feature)
		  2.	Otherwise, if your field is a date field, it will sort in chronological order
		  3.	Lastly, if you don’t have an order-by column or date field, Power BI Desktop will sort by the measure descending.

Of course, as always, Power BI will always respect any sort order you select manually.

Numeric Slicer now Generally Available

The numeric range is now Generally Available (GA) to use.  You’ll see it a slicer type option for numeric columns without needing to turn on a Preview 
feature.  Additionally, any newly created slicers using numeric columns will default to the ‘between’ mode of the numeric range slicer.

Update your linguistic schema

Now that Q&A has been integrated into both the report authoring and 
consuming experience, this update also considers improving the results 
you get back when you ask questions.  To help with this, Microsoft has 
added the capability to export your linguistic schema in YAML format.  
You can then make edits to the schema such as adding phrasing and 
synonyms and otherwise customise the language model that Q&A uses  

 
to understand questions about your data.  You can then import your 
modified schema back into Power BI Desktop.  

This capability is available under the ‘Linguistic Schema’ button on the 
‘Q&A’ group at the end of the ‘Modeling’ Ribbon tab:

Organisational visuals now Generally Available

In February Microsoft released the Organizational visuals, a simple way to deploy and manage custom visuals inside organisations, in Preview.  These 
visuals are now Generally Available (GA).  This means it is available out-of-the box for both Power BI Desktop and the Power BI service.

New DAX function: COMBINEVALUES()

This month’s update also sees a new DAX function COMBINEVALUES(), 
that allows multi-part keys to be handled in a more efficient way when 
using DirectQuery.  

Power BI doesn’t directly support relationships that use multi-part 
keys.  For example, consider the relationship between Shipment, 
and OrderLine in a mock table.  If an OrderLine is uniquely identified 
by a combination of OrderID and LineID, then the relationship from 
Shipment to OrderLine would need to use those pair of columns.  The 
common workaround is to create a calculated column on each table, that 
combines the values with some separator.  For example:

Key = CONCATENATE(CONCATENATE([OrderID],":"),[LineID])

Then the relationship can be defined as normal.  The problem with this 
workaround is when your using DirectQuery since now cases which 
require a join between the two tables will send a SQL query that joins 
on an expression.  This often results in indices no longer being used and 
therefore produces a less efficient query.

 
The new COMBINEVALUES function takes as arguments a separator (e.g. 
“:”) and one or more expressions.  It will concatenate the values of all the 
expressions, with the given separator.  For example, in the case above, 
the calculated column can now be defined using the expression:

Key = COMBINEVALUES(":",[OrderID],[LineID])

This is still simply a DAX expression, and the calculated columns are still 
used in the relationship as before.  The difference is that this is then 
optimised, such that upon joining using this relationship, the condition 
defined in the SQL query decomposes back to use the underlying 
columns [OrderID] and [LineID] directly.  This generally results a much 
more efficient SQL query.

As another use case for this new DAX function, you might also want to 
use this function to join a set of values with a common delimiter without 
having a set of nested CONCATENATE() functions.
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Organisational visuals now Generally Available

In February Microsoft released the Organizational visuals, a simple way to deploy and manage custom visuals inside organisations, in Preview.  These 
visuals are now Generally Available (GA).  This means it is available out-of-the box for both Power BI Desktop and the Power BI service.

Overview by CloudScope

The Overview by CloudScope custom visual is a presentation visual for list-oriented data, with the data appearing in a format similar to Instagram:

You should note that your Power BI administrator must add custom visuals to the organisational repository before you will be able to see any visuals 
in this experience.  Further, with this GA, Microsoft has added support for organisation visuals to be supported in Publish to Web, as well as support 
for the administrator to update the visual package and disable visuals.

The control can display any of the following:

	 •	 image or icon
	 •	 screen name or headline
	 •	 account name
	 •	 account description
	 •	 clickable hyperlink
	 •	multiple data fields.

You can use this visual to cross-highlight other visuals on your report as well.
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Icon Map by Altius

The Icon Map by Altius visual allows you to show data bound images, lines and circles on a map:

Hexbin Scatterplot

The Hexbin Scatterplot custom visual by David Eldersveld displays points on top of hexagonal "bins".  Each hexbin’s color is based on the density of 
points within each bin, with darker bins showing more points.  You may control whether just the points, just the bins or both show up in addition to 
having formatting control over both.

Adobe Analytics connector now Generally Available

This month sees the General Availability of the Adobe Analytics connector, which has been developed in partnership with Adobe.  The connector has 
been available as a Preview connector since the December 2017 release of Power BI Desktop.

Some features of this map include:

	 •	 formatting control over the size of circles on the map
	 •	 show images in place of circles
	 •	 connect circles or images with lines
	 •	 select from different tile layers, include MapBox and Thunderforest if you have the appropriate API key
	 •	 add real-time weather layers with an OpenWeatherMap API key
	 •	 show the real-time daylight curve.
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The Adobe Analytics connector can be found in the “Get Data” dialog under the Online Services category:

After selecting the Adobe Analytics connector, you may authenticate using your Adobe ID account credentials (assuming you have some!).
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Once the connection has been successfully established, you may preview and select multiple dimensions and measures within the ‘Navigator’ dialog 
to create a single tabular output.  As part of this selection, you may also provide any necessary input parameters for the selected items.

After selecting the desired information, you can decide to directly load your query into Power BI Desktop or perform any additional data transformations 
and filters within the Query Editor UX upfront, via the ‘Edit option’ in this dialog.

SAP HANA connector improvement: Port selection

An improvement to the SAP HANA connector in this release enables 
users to explicitly select the Port to use in order to connect to an SAP 
HANA server.  In previous releases, Port could be specified as part of the 
Server input field.  However, the default Port when not specified would 
not distinguish between single-container and multi-container SAP HANA 
servers.

 
With this feature enhancement, users can now specify what type of SAP 
HANA server they are connecting to and get an optimised Port default 
for it, or alternatively select the ‘Custom’ option to specify a different 
port number.

Dynamics 365 Business Central connector

A new connector in this update allows you to connect to Dynamics 365 
Business Central, previously known as Dynamics 365 for Financials.  
The new Dynamics 365 Business Central connector can be found under 
the ‘Online Services’ category in the ‘Get Data’ dialog.  This connector 
is now also Generally Available.

More next month no doubt!
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It wasn’t just the Desktop version of Power BI that was worked on.  Microsoft has also rolled out the following new and improved features for Power 
Service and Mobile:

	 •	 Persistent filters in the Service and Mobile
	 •	Organisational custom visuals Generally Available
	 •	HITRUST CSF certification
	 •	Mixed reality app (Preview)
	 •	March update for On-premises data gateway
	 •	B2B support on Mobile.

Let’s take a brief look at each.

Latest Updates for Power BI Service and Mobile

Persistent filters in the Service and Mobile

It’s now easier for report consumers to pick up right where left off in the 
Power BI Service and Mobile.  All Power BI reports will now automatically 
retain the filters, slicers, and other data view changes made by the user.  

In the Service version, users will now see a new “Reset to default” button 
with a yellow icon in the top bar.  This will light up whenever you make 
any changes to the report from the published version.  The report state  

is captured after 60 seconds or immediately when you navigate away to 
another dashboard or report.  This button may be used to revert to the 
published view at any time.  Having said that, we do note that reports 
with custom visuals are not supported – yet.  Microsoft states they “…
are working with custom visual developers to enable these soon…”.  We 
await with bated breath.

Organisational custom visuals Generally Available

Since last month’s release of the organisation visuals Preview, Microsoft 
has fixed many of the bugs identified and made additional improvements 
too.  Administrators may now update the package and its details  

 
(e.g. versions) for existing published custom visuals.  Also, organisation 
visuals are now supported in ‘Publish to Web’ reports.  Consequently, 
this feature has now become GA (Generally Available).

HITRUST CSF certification

Given that organisations have a diverse set of compliance and regulatory 
requirements that need to be met concerning their data security  
and privacy, Power BI has added to the existing 22 certifications and  

attestations to provide users with further reassurance.  April saw 
Microsoft announce that Power BI has now been certified under the 
HITRUST Common Security Framework (CSF) 8.1 certification criteria.

Mixed reality app (Preview)

Power BI has teamed up with Microsoft Hololens to release a preview 
of the Power BI for Mixed Reality app.  This app makes it easy to access 
your Power BI content while using HoloLens, allowing users to view and  

 
interact with report pages and dashboards on top of your real-world 
environment.  You can download this app from the Microsoft Store now.

March update for On-premises data gateway

There’s also a new update for the Power BI On-premises data gateway.  The latest update includes a new version of the mashup engine and an update 
to make it easier for users to determine the release month of the installed gateway right next to the version.  You can learn more by installing the 
new gateway and having a play.
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B2B support on Mobile

Power BI Mobile now supports a key B2B feature: finally, you may now share dashboards and reports with users external to the organisation, on the 
go.  External sharing in enabled for both organisational and – at long last – social accounts.

More soon, we’re sure.

The CONFIDENCE function employs the following syntax to operate:

CONFIDENCE(alpha, standard_dev, size)

	 •	alpha: this is required.  This represents the significance level used to compute the confidence level.  The confidence level equals  
		  100*(1 - alpha)%, or in other words, an alpha of 0.05 indicates a 95 percent confidence level
	 •	 standard_dev: this is also required.  This is the population standard deviation for the data range and is assumed to be known
	 •	 size: also required. This is the sample size.

It should be further noted that: 

	 •	 if any argument is non-numeric, CONFIDENCE returns the #VALUE! error value
	 •	 if alpha is ≤ 0 or ≥ 1, CONFIDENCE returns the #NUM! error value
	 •	 if standard_dev ≤ 0, CONFIDENCE returns the #NUM! error value
	 •	 if size is not an integer, it is truncated
	 •	 if size < 1, CONFIDENCE returns the #NUM! error value
	 •	 if we assume alpha equals 0.05, we need to calculate the area under the standard normal curve that equals 1 - alpha, or 95%.  This value is ± 	
		  1.96.  The confidence interval is therefore:

Do you need more CONFIDENCE in your Excel files?  This function 
returns the confidence interval for a population mean, using the theory 
associated with the normal distribution.

To explain, the confidence interval is a range of values around a sample 
mean, x, which sits at the centre of this range, i.e. the range is x ± 
CONFIDENCE.  For example, if x is the sample mean of delivery times 
for products ordered through the mail, x ± CONFIDENCE is a range of 
population means.  

For any population mean, μ0, in this range, the probability of obtaining 
a sample mean further from μ0 than x is greater than the significance 

level required, alpha; for any population mean, μ0, not in this range, the 
probability of obtaining a sample mean further from μ0 than x is less 
than this level, alpha.  In other words, assume that we use x, a standard 
deviation standard_dev, and size to construct a two-tailed test at 
significance level alpha of the hypothesis that the population mean is μ0.  
Then we will not reject that hypothesis if μ0 is in the confidence interval 
and will reject that hypothesis if μ0 is not in the confidence interval.  The 
confidence interval does not allow us to infer that there is probability 
1 – alpha that our next package will take a delivery time that is in the 
confidence interval.

The A to Z of Excel Functions: CONFIDENCE
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	 •	 this function has been superseded (see below).

Please see our example below:

We suppose this function is more the NORM…  This function first appeared in Excel 2010 but is simply an updated version of the CONFIDENCE 
function, which is available in earlier versions of Excel.  Again, this returns the confidence interval for a population mean, using the theory associated 
with the normal distribution.

The CONFIDENCE.NORM function employs the following syntax to operate:

CONFIDENCE.NORM(alpha, standard_dev, size)

	 •	alpha: this is required.  This represents the significance level used to compute the confidence level.  The confidence level equals  
		  100*(1 - alpha)%, or in other words, an alpha of 0.05 indicates a 95 percent confidence level
	 •	 standard_dev: this is also required.  This is the population standard deviation for the data range and is assumed to be known
	 •	 size: also required. This is the sample size.

It should be further noted that: 

	 •	 if any argument is non-numeric, CONFIDENCE.NORM returns the #VALUE! error value
	 •	 if alpha is ≤ 0 or ≥ 1, CONFIDENCE.NORM returns the #NUM! error value
	 •	 if standard_dev ≤ 0, CONFIDENCE.NORM returns the #NUM! error value
	 •	 if size is not an integer, it is truncated
	 •	 if size < 1, CONFIDENCE.NORM returns the #NUM! error value
	 •	 if we assume alpha equals 0.05, we need to calculate the area under the standard normal curve that equals 1 - alpha, or 95%.  This value is ± 	
		  1.96.  The confidence interval is therefore:

Please see the example below:

The A to Z of Excel Functions: CONFIDENCE.NORM
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Have you got your CONFIDENCE down to a T?  This function first appeared in Excel 2010 but unlike CONFIDENCE.NORM there was no equivalent in 
earlier versions of Excel.  That is because this function returns the confidence interval for a population mean, using a Student’s t distribution.

The CONFIDENCE.T function employs the following syntax to operate:

CONFIDENCE.T(alpha, standard_dev, size)

	 •	alpha: this is required.  This represents the significance level used to compute the confidence level.  The confidence level equals  
		  100*(1 - alpha)%, or in other words, an alpha of 0.05 indicates a 95 percent confidence level
	 •	 standard_dev: this is also required.  This is the population standard deviation for the data range and is assumed to be known
	 •	 size: also required. This is the sample size.

It should be further noted that: 

	 •	 if any argument is non-numeric, CONFIDENCE.T returns the #VALUE! error value
	 •	 if alpha is ≤ 0 or ≥ 1, CONFIDENCE.T returns the #NUM! error value
	 •	 if standard_dev ≤ 0, CONFIDENCE.T returns the #NUM! error value
	 •	 if size is not an integer, it is truncated
	 •	 if size < 1, CONFIDENCE.T returns the #DIV/0! error value

Please see our final example for this month below: 

The A to Z of Excel Functions: CONFIDENCE.T

Upcoming SumProduct Training Courses

Location Course Date Duration

Melbourne Financial Modelling 1 - 2 May 2018 2 days

Melbourne Power Pivot, Power Query and Power BI 7 - 9 May 2018 3 days

Auckland Financial Modelling 21 - 22 May 2018 2 days

Wellington Financial Modelling 24 - 25 May 2018 2 days

Darwin Financial Modelling 4 - 5 Jun 2018 2 days

Sydney Power Pivot, Power Query and Power BI 18 - 20 Jun 2018 3 days

Sydney Financial Modelling 25 - 26 Jun 2018 2 days

Melbourne Excel Tips & Tricks 2 Jul 2018 1 day

Melbourne Financial Modelling 3 - 4 Jul 2018 2 days

Melbourne Power Pivot, Power Query and Power BI 17 - 19 Jul 2018 3 days

Sydney Excel Tips & Tricks 13 Aug 2018 1 day

Sydney Financial Modelling 15 - 16 Aug 2018 2 days
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 		
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from
http://www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month we are on the up and 
up as we focus on the Up Arrow key:

There are over 540 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file a
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Keystroke What it does

Down Arrow Move down one cell

ALT + Down Arrow Open drop-down (auto-complete, filter or validation)

CTRL + Down Arrow Select the last cell in the current region

SHIFT + Down Arrow Extend selection down one cell

CTRL + ALT + Down Arrow Intel Chipset: Invert screen display (180 degrees orientation)

CTRL + SHIFT + Down Arrow Extend selection down to the last cell in the region

Brisbane Excel Tips & Tricks 27 Aug 2018 1 day

Brisbane Financial Modelling 28 - 29 Aug 2018 2 days

Sydney Power Pivot, Power Query and Power BI 10 - 12 Sep 2018 3 days

Perth Financial Modelling 17 - 18 Sep 2018 2 days

Perth Power Pivot, Power Query and Power BI 19 - 21 Sep 2018 3 days


